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ABOUT THIS RELEASE 
This document describes the enhancements for ERDAS IMAGINE 2018 Update 2 (v16.5.2), including 
IMAGINE Photogrammetry (formerly LPS Core) and ERDAS ER Mapper. Although the information in this 
document is current as of the product release, see the Hexagon Geospatial Support website for the most 
current version.  

This release includes both enhancements and fixes. For information on fixes that were made to ERDAS 
IMAGINE for this release, see the Issues Resolved section. 

This document is only an overview and does not provide all the details about the product's capabilities. See 
the online help and other documents provided with ERDAS IMAGINE for more information. 

Update 2 for ERDAS IMAGINE 2018 primarily provides extended Machine Learning capabilities, especially in 
regard to improvements to the Machine Learning Layout for training, executing and reviewing machine 
learning projects and new Operators aimed at Object Detection. 

In addition, there are new Operators, such as the Union Features operator, as well as numerous software 
quality improvements. 

ERDAS IMAGINE PRODUCT TIERS 
ERDAS IMAGINE® performs advanced remote sensing analysis and spatial modeling to create new 
information. In addition, with ERDAS IMAGINE, you can visualize your results in 2D, 3D, movies, and on 
cartographic-quality map compositions. The core of the ERDAS IMAGINE product suite is engineered to 
scale with your geospatial data production needs. Optional modules (add-ons) providing specialized 
functionalities are also available to enhance your productivity and capabilities. 

IMAGINE Essentials® is the entry-level image processing product for map creation and simple feature 
collection tools. IMAGINE Essentials enables serial batch processing. 

IMAGINE Advantage® enables advanced spectral processing, image registration, mosaicking and image 
analysis, and change detection capabilities. IMAGINE Advantage enables parallel batch processing for 
accelerated output. 

IMAGINE Professional® includes a production toolset for advanced spectral, hyperspectral, and radar 
processing, and spatial modeling. Includes ERDAS ER Mapper. 

IMAGINE Photogrammetry maximizes productivity with state-of-the-art photogrammetric satellite and aerial 
image processing algorithms. 
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NEW PLATFORMS 

ARCGIS 10.6.1 

ERDAS IMAGINE 2018 Update 2 has been tested and declared Supported when using an installed and 
licensed version of ArcGIS 10.1 through 10.6.1 in order to provide Geodatabase support libraries. 
Alternatively, the IMAGINE Geodatabase Support component (based on ArcGIS Engine 10.5) can be 
installed to provide Geodatabase support. 

Note that since the Geodatabase support libraries are 32-bit, Geodatabases are only supported when 
running ERDAS IMAGINE 2018 (32-bit). 

NEW LICENSING 

ERDAS IMAGINE 2018 was delivered with version 16.5.0.11 of the Hexagon Geospatial Licensing 2018 
tools. However it is strongly recommended that all ERDAS IMAGINE customers upgrade to v16.5.0.20 (or 
higher). The appropriate download can be found on the Downloads section of the Hexagon Geospatial web 
site: 

https://download.hexagongeospatial.com/downloads/other/geospatial-license-administrator-2018 

Hexagon Geospatial Licensing 2018 v16.5.0.20 is also integrated into the ERDAS IMAGINE 2018 Update 2 
installer, so any computer where you install Update 2 should also have any existing installation of Hexagon 
Geospatial Licensing 2018 automatically updated to v16.5.0.20. If in doubt, refer to Windows’ Add or Remove 
Programs utility to determine the currently installed version. 

NEW TECHNOLOGY 

OBJECT EXTRACTION USING DEEP LEARNING 
Object detection from remotely sensed data is one the primary tasks Image Analysts perform in their day to 
day activity. Object detection is challenging because of the large variations in the appearance of objects 
caused by atmospheric conditions during image capture and other factors such as view angle, age of the 
object and background differences.  

Various methods have been developed for performing object extraction including template matching, rule-
based (knowledge based) and Object Based Image Analysis (OBIA) methods. 

Until recently, OBIA object detection methods such as IMAGINE Objective have been widely accepted as the 
best method for performing object detection tasks. OBIA methods involve segmenting images into relatively 
homogenous groups of pixels (objects) based on desired scale, shape and compactness criteria and then 
classifying the objects. This involves a trial-and-error process and often has to be adapted for each data type 
and/or object to be identified. 

Recent advances in Deep Learning have shown promising results over OBIA object detections methods, both 
in terms of ease of use and rate of success. Deep Leaning algorithms learn about objects directly from 
training images and identify similar objects in new images.  

In this release, we have added deep learning-based operators that learn from and perform object detection. 

https://download.hexagongeospatial.com/downloads/other/geospatial-license-administrator-2018
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INITIALIZE OBJECT DETECTION 

This operator defines and trains a deep neural network to generate a machine intellect that can be used for 
detecting objects in images using the Detect Objects Using Deep Learning operator.  

Spatial Modeler Deep Learning Expansion Pack 2018 is a pre-requisite and must be installed for proper 
operation of this operator.  

 

DETECT OBJECTS USING DEEP LEARNING 

This operator performs object detection on the input raster and extracts the bounding box of the detected 
objects. This is done using the trained deep-learning based object detector specified on the MachineIntellect 
port.  The extracted bounding boxes are added to the output feature stream. 

Spatial Modeler Deep Learning Expansion Pack 2018 is a pre-requisite and must be installed for proper 
operation of this operator. 
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SPATIAL MODELER DEEP LEARNING EXPANSION PACK   

Spatial Modeler Deep Learning Expansion Pack 2018 is a separate installer that powers object detection 
functionality in ERDAS IMAGINE 2018.  

The expansion pack must be installed along with ERDAS IMAGINE 2018 Update 2 to perform Objection 
Detection tasks using the Spatial Modeler operators Initialize Object Detection and Detect Objects Using 
Deep Learning.   

FASTER R-CNN OBJECT DETECTION ALGORITHM 

Faster R-CNN (Region-based Convolutional Neural Networks) is included and used as the algorithm for 
detecting objects. Faster R-CNN is a descendent of R-CNN that has been optimized for speed.  

In general R-CNN family of algorithms work by identifying regions of interest (bounding boxes) in the image, 
classifying the identified regions of interest using CNN and, if an object is found, tightening the bounding box 
to fit the object identified in the region. 

GPU SUPPORT FOR DEEP LEARNING BASED OBJECT DETECTION 

Deep learning needs considerable hardware power to run efficiently. GPU acceleration significantly speeds 
up the training and object detection processes thereby increasing productivity.  

We have enabled our Deep Learning operators to use NVIDIA’s CUDA® Deep Neural Network library. The 
operators will use GPU acceleration on systems that have the appropriate Graphics Card. 

OTHER NEW OPERATORS FOR SPATIAL MODELER  

 

Hexagon Geospatial has continued to add new operators to Spatial Modeler. New (or modified) operators 

with a brief description of their capabilities are described below. See the ERDAS IMAGINE 2018 Help for full 

details of each operator, as well as the Hexagon Geospatial Community > Spatial Modeler Tutorials page, for 

examples of Spatial Models that use many of these capabilities. 

ASSESS CLASSIFICATION ACCURACY 

Assess Classification Accuracy operator performs accuracy assessment based on attributes of feature data 

that represent the reference class and the classification result.  

 

ADD ATTRIBUTES BY LOCATION 

Add Attributes By Location extends the schema of features with attributes from RelatedData and, for each 

feature, conditionally populates the values of these extended attributes with values from RelatedData. 

 

https://arxiv.org/pdf/1506.01497.pdf
http://community.hexagongeospatial.com/t5/Spatial-Modeler-Tutorials/tkb-p/KS_SpatialModeler_AnalyticalRecipes
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For example, this operator could be used to add an attribute to point features that contains height values 

derived from a raster DEM. 

CLASSIFY GROUND 

Classify Ground operator classifies unclassified points of a point cloud points into 2 groups - ground and non-

ground using an iterative process known as Adaptive TIN. 

 

CLASSIFY NOISE 

Classify Noise operator identifies outlying points from a point cloud and assigns them to the Low Noise class 

(class 7).  

 

CREATE RANDOM POINTS 

Create Random points operator generates the specified number of 2D points within the extent of a 

Geospatial Data. 

 

GET GEOMETRIC MODEL INFO 

The Get Geometric Model Info operator has been updated to additionally identify the Grid Type. The 
GridType output may be any of the following: "Rectified", "Referenced", "Referenceable", "Unreferenced", or 
"None" (if the georeferencing is not an operation suitable in the Spatial Modelling environment for relating a 
grid to an external coordinate reference system). The GridType values "Rectified" and "Referenceable" are 
defined by ISO 19123 (which definitions are identical to the definitions in Abstract Topic 6 of the Abstract 
Specifications of the OGC). 
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CREATE BUFFER ZONE 

The Create Buffer Zone operator creates buffer zones around or within geometries at a specified distance.  A 
buffer zone is the set of all points that are within a specified distance of a given geometry. 

 

The following figures show different geometries (gray, areas are hatched) with the buffer zones around them 
(red).  One example for a point geometry, two for a line geometry, two for an area geometry. 

 

CREATE BUFFER RING 

The Create Buffer Ring operator creates buffer rings around or within geometries at specified distances.  A 
buffer ring is the set of all points that are within a specified distance range of a given geometry. 

 

The following figures show different geometries (gray, areas are hatched) with the buffer rings around them 
(red).  One example for a point geometry, two for a line geometry, two for an area geometry. 
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UNION FEATURES 

Unions two or more sets of features into a single combined set of features, when they have identical or 
similar schemas 

 

The functionality of this operator parallels the union capability provided by SQL and most relational database 
management systems.  Union provides the ability to record-wise append multiple tables/views (relations) in 
query results to create an output that is the logical union of the input records.  In some sense it is a record-
wise equivalent to the field-wise append provided by the Join Features operator. 

This operator receives two or more FeaturesIn and unions them into a single FeaturesOut.  The number of 
feature instances in FeaturesOut is the sum of the count of each FeaturesIn.  The schema of FeaturesOut is 
determined by the FeaturesIn1 port or by a reconciliation of the schemas of all the FeaturesIn 
ports.  Geometry is not involved in the behavior of the operator other than being carried through into 
FeaturesOut, and no geometry field is required on input or output. 

If the schemas of the various Features input to the union do not match completely, they must be 
reconciled.  The SchemaMode port determines the mode of reconciliation: 

• First Schema.  The fields of FeaturesOut are determined by the fields of FeaturesIn1, and fields from 
other FeaturesIn ports are either matched to those in FeaturesIn1, or excluded from output. 

• Union Schemas.  FeaturesOut includes all fields from all FeaturesIn ports, no fields from any 
FeaturesIn port excluded from output. 

• Intersect Schemas.  FeaturesOut includes all fields common to all FeaturesIn ports, and all other 
fields are excluded from output.  If there are no fields in common, then an error occurs. 

Fields are matched by name (case-insensitive comparison) and data type.  If there is a mismatch in the data 
type of fields sharing a common name, then behavior varies by SchemaMode: 

• First Schema.  The field in FeaturesOut comes from the field of FeaturesIn1. 

• Union Schemas.  An error occurs. 

• Intersect Schemas.  The field is dropped from FeaturesOut. 
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JOIN FEATURES 

Joins two sets of features into a single combined set of features, by pairing individual features from each set 
based on attribute matches. 

 

The functionality of this operator parallels the join capability provided by SQL and most relational database 
management systems.  Join provides the ability to field-wise append two tables/views (relations) in query 
results to create an output that is the logical union of the input schemas.  In some sense it is a field-wise 
equivalent to the record-wise append provided by the Union Features operator. 

This operator receives two FeaturesIn, designated left and right, and joins them into a single 
FeaturesOut.  The number of feature instances in FeaturesOut depends upon the count of each FeaturesIn, 
the number of matches found between them based on MatchAttributeNames, and the JoinType.  The 
schema of FeaturesOut is that of FeaturesInLeft followed by that of FeaturesInRight.  Geometry is not 
involved in the behavior of the operator other than being carried through into FeaturesOut, and no geometry 
field is required on input or output. 

By default, with a JoinType of Inner, a new feature is created in the FeaturesOut port for each pair of features 
from the FeaturesInLeft and FeaturesInRight ports which have matching values in all fields identified by the 
MatchAttributeNames port.  If the JoinType port is something other than Inner then additional features will be 
output representing unmatched features from FeaturesInLeft, FeaturesInRight, or both.  JoinType may have 
the following values: 

• Inner.  An inner join is one in which features are joined only if the values from the FeaturesInLeft 
attributes (as identified via the MatchAttributeNames port) match the corresponding values from the 
FeaturesInRight attributes.  Features that do not match are not output. 

• Left.  A left outer join is one in which all features from FeaturesInLeft are output, but only matching 
rows from FeaturesInRight are output.  Features from FeaturesInRight that do not match are not 
output.  Features from FeaturesInRight with unmatched values are assigned null values for the fields 
from FeaturesInRight. 

• Right.  A right outer join is one in which all features from FeaturesInRight are output, but only 
matching rows from FeaturesInLeft are output.  Features from FeaturesInLeft that do not match are 
not output.  Features from FeaturesInRight with unmatched values are assigned null values for the 
fields from FeaturesInLeft. 

• Full.  A full outer join is one in which all features from both FeaturesInLeft and FeaturesInRight are 
output.  Any features from either FeaturesIn port that have unmatched values from the the other 
FeaturesIn port are assigned null values for the fields from that other port. 

Null values are considered not equal to one another.  Features with null values for any of the match attributes 
are never joined to other features. 

All fields from the two sets of features are included in the FeaturesOut schema.  In order to ensure 
uniqueness of output field names, as well as predictability in the names of output fields, all output field names 
are suffixed with "_L" (for FeaturesInLeft) or "_R" (for FeaturesInRight). 
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Identity of input features is not carried through to output.  If both FeaturesInLeft and FeaturesInRight have 
defined primary keys, then the primary key of FeaturesOut is a composite (multi-field) key composed of the 
key fields from each of the two input sets of features.  Unique indexes are changed to non-unique 
indexes.  Autonumber fields become standard integer fields and no longer behave as autonumbers.  The 
Required property of a field is set to False for any field which may have a Null value in FeaturesOut as a 
result of the JoinType. 

The primary geometry field of FeaturesOut is determined by the following precedence: 

• The primary geometry field of FeaturesInLeft, if there is one. 

• The primary geometry field of FeaturesInRight, if there is one. 

• The first geometry field within the schema of FeaturesOut, if there is one. 

SUMMARIZE RELATED FEATURES 

Relates one set of features (the detail features) to another set of features (the summary features) based 
on spatial relationships and/or attribute matches, summarizing data from the detail features onto the 
summary features via functional attributes 

 

This operator relates one set of features (the detail features) to another set of features 
(the summary features) based on spatial relationships and/or attribute matches, summarizing data from the 
detail features onto the summary features via functional attributes. 

The summary features are provided through the FeaturesIn port, and the detail features are provided through 
the DetailFeatures port. 

The input features may be nongraphic (no primary geometry field), or may have point, line, area, or vector 
geometry fields. 

If the primary geometry fields of the two sets of input features have different CRS's, then DetailFeatures are 
automatically transformed to match FeaturesIn. 

All geometry types are supported including arcs, composites, collections, and boundaries with holes.  Z 
values are retained and used as appropriate. 

This is a global sink operator, as it must evaluate all features and relate them before the first output can be 
produced. 

This is a two-step operation, involving first the relating of detail features to summary features, then second 
the creation of new attributes on the summary features. 
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Step 1:  Relating 

The summary features given through the FeaturesIn port are compared with the detail features given through 
the DetailFeatures port, for matches in each of the identified attribute pairs (if any), and/or a spatial 
relationship between the pair of primary geometry fields.  There is a logical “and” among all of these 
association criteria.  SpatialRelationship must be set to something other than None, or MatchAttributeNames 
set to have at least one pair, otherwise an error is thrown. 

Null values are considered not equal to one another whether found in attributes or geometry fields.  Features 
with null values for any of the match attributes or the primary geometry field are never related to other 
features. 

The result is zero, one, or more detail features related to each summary feature.  Not every detail feature 
may be related to a summary feature.  In the event that a detail feature is related to more than one summary 
feature, the AssignmentMode port determines how the detail feature is assigned (to none, to all, to the first, 
etc.). 

Step 2:  Summarizing 

The set of detail features related to a specific summary feature (if any), are summarized onto the summary 
feature.  The result is one or more new fields on the summary features.  The new fields are defined by the 
SummaryAttribute ports, which summarize the data of the related detail features using expressions.  The 
original schema of the summary features found on the FeaturesIn port is otherwise unchanged, as is the 
primary key. 

Some expression functions that are useful in summarizing data: 

• It is common for one summary attribute to count the number of related detail features, using an 
expression of the form “COUNT(*)”. 

• It is also common to compute summary statistics on numeric attributes of related detail features (for 
example SUM or AVERAGE). 

• The geometries of detail features can be summarized, for example by calculating the total perimeter 
of a set of areas. 

• The minimum distance between each related summary/detail feature pair is available through a 
special DISTANCE expression function. 

Example Usage 

To find the single nearest grocery (detail) for each house (summary): 

• SpatialRelationship = Accumulate Nearest 

• MatchAttributeNames = <None> 

• AssignmentMode = First 

Then compute summary attributes using expressions such as: 

• FIRST(DetailFeatures.StoreName) can be used to get the name of the nearest grocery 
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• FORMATMEAS(DISTANCE(FeaturesIn.Geometry, FIRST(DetailFeatures.Geometry)), 
FormatType.Distance, Mile, 2) can be used to get the distance of the nearest grocery in miles to 2 
decimal places 

  

To assign every house (detail) to its nearest grocery (summary): 

• SpatialRelationship = Nearest To 

• MatchAttributeNames = <None> 

• AssignmentMode = All 

Then compute summary attributes using expressions such as: 

• COUNT(*) can be used to count the number of houses which are closest to each grocery 

• FIRST(DetailFeatures.CustomerName) can be used to get the name of the nearest of the customers 
for whom each grocery is the closest 

• CONCATENATE(“,”,DetailFeatures.CustomerName) can be used to obtain a comma-separated list 
of the names of customers which are closest to each grocery 

• AVERAGE(FORMATMEAS(DISTANCE(FeaturesIn.Geometry, FIRST(DetailFeatures.Geometry)), 
FormatType.Distance, Mile, 2)) can be used to get the average distance to the houses nearest the 
grocery, in miles to 2 decimal places 
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IMAGE CHAIN DISPLAY IMPROVEMENTS 
In ERDAS IMAGINE 2015 we introduced a new way of displaying imagery in the 2D View (as an alternative 
to the Raster layer) termed the Image Chain. Image Chains use Spatial Models to apply styling to the raster 
data being passed through them and to the display in a 2D View. The use of Spatial Models to do this 
provides a very robust way of manipulating the image styling, such as the addition of standardised Softcopy 
Image Processing Standards (SIPS) Image Chains in subsequent releases. 

DTED DEM displayed via the Relief Image Chain: 

 

Since the Image Chain is a new layer type, not all functionality that was available for interacting with Raster 
layers was available with Image Chains. With the release of Update 2 we have made a significant increase in 
the number of tools that now interact with data displayed via Image Chains, to the point where Image Chain 
is now a standard option on the Raster File Chooser’s Raster Options tab.  

Here’s a selection of Image Chain improvements that can be found in Update 2: 

FILE CHOOSER 

When selecting an image file to be displayed in the 2D View the Raster Options tab now includes an option to 
Display As an Image Chain. This makes it easier to choose when you want to use the Image Chain, rather 
than having to use the separate File > Open > Raster As Image Chain option. 
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PREFERENCE FOR DEFAULT BEHAVIOR 

As indicated in the screenshot above (with the star button next to the Display As options) a Preference is now 
available to set whether you want to open raster data as a Raster or Image Chain layer by default. This is 
especially useful if you regularly open data by dragging and dropping from Windows Explorer to a 2D View or 
by double-clicking a file in Windows Explorer. 

The Preference can also be accessed and set via the Preference Editor (File > Preferences) via the Viewing 
> Viewer > Default Raster Rendering Engine preference. 

UP IS UP AND IMAGE CHAINS 

When exploiting imagery that was captured from a non-nadir viewing angle it’s common practice to rotate the 
data so the viewing direction is oriented up the screen. In this way the layover occurs up the screen so, for 
example, building lean is “away from the observer” and is thereby much easier to interpret.  
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In previous versions, when displaying image data as an Image Chain layer the Home tab > View group > 
Align to Up is Up option was not available. This option has now been enabled for data displayed as Image 
Chain. 

TRANSFORM AND ORTHO TOOLS 

As indicated in the screenshot above, all tools in the Transform & Orthocorrect group are now enabled to 
work with data displayed using the Image Chain, including the Single Point Tool for “drop pointing” an image 
that has an affine offset from its correct location. 

STATUS BAR GEOMETRIC MODEL AND HEIGHT 

Also indicated in the screenshot above, the Status Bar at the bottom of the ERDAS IMAGINE window now 
displays additional information regarding the active image. As well as map coordinate information, the Status 
Bar now also displays the geometric model being used to provide those coordinates as well as the height at 
the cursor location and the source of that height information. 

FILE CHOOSER IMPROVEMENTS 

Largely in support of multi-segment NITF data, but also of use when displaying any multi-image file or 
selection of files, the File Chooser now provides additional options. 
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MULTI-SEGMENT/IMAGE FILE INPUT 

When a selected file contains multiple segments or images, each can be treated as a discrete image layer 
and all added to a single 2D View, or each one can be sent to a separate View, all of which are 
geographically linked. Useful when the data in the file is a “stack” that you want to compare side by side. 

The selection shown below would send the seven selected sub-image segments to a single 2D View: 
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Whereas the selection shown below would send the two segments to two separate 2D Views (and 
geographically link the two, if possible): 
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MULTIPLE FILES INPUT 

When selecting multiple files in the File tab… 

 

…the Multiple tab will, in a similar fashion, provide a new option to send those individual files to separate, 
new 2D Views (and link them if possible), as well as the old options to stack them into a single 2D View (or to 
treat them as a single Virtual dataset in a single View): 
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EXPANDABLE SEGMENT LIST 

On the Sub-Images tab, the area which lists the available segments to choose from now expands when the 
dialog itself is resized, making it much easier to select the desired segments form files which may contain 
dozens, if not hundreds, of segments to choose from. 
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GENERAL ERDAS IMAGINE 

PERFORMANCE IMPROVEMENT FOR DEEP LEARNING BASED CLASSIFICATION 

The training of Convolutional Neural Networks (CNN) and classification based on them has been enhanced 
by an order of magnitude. 

TOOLS FOR TRAINING DATA COLLECTION FOR DEEP LEARNING 

Image classification and object detection using Convolutional Neural Networks (CNN) requires that the 
network first be trained with image chips and object footprints. Collection of image chips and/or object 
footprints is a time-consuming process. 

We have added tools that alleviate the collection and extraction of image chips and object footprints in the ML 
Train tab of the Machine Learning Layout of ERDAS IMAGINE. This Layout can be accessed by selecting 
File menu > Layout > Machine Learning Layout  

 

NEW ZEALAND VERTICAL DATUM 2016 (NZVD2016) 

New Zealand Vertical Datum 2016 (NZVD2016) has been named the official vertical datum for New Zealand 

and its offshore islands. It defines an orthometric height defined by New Zealand Geoid 2016 

(NZGeoid2016).  

 

Support for NZVD2016 is added in ERDAS IMAGINE 2018 Update 2. The datum can be selected from the 

Elevation info chooser for setting the vertical datum of 3D data whose elevation is based on NZVD2016, or 

for height conversion from/to other vertical datum. 
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ORDNANCE SURVEY NATIONAL GRID TRANSFORMATION MODEL (OSTN15) 

OSTN15 is a transformation grid, developed by Ordnance Survey of Great Britain, that consists of a 700km 
by 1,250km grid of translation vectors at 1km resolution. It provides a fit between the GNSS coordinate 
system European Terrestrial Reference System 1989 (ETRS89) and the OSGB36 National Grid.  

OSTN15, in conjunction with the ETRS89 positions of the OS Net® permanent GNSS stations, is now the 
official definition of OSGB36 National Grid coordinate system. 

Two datum transformations have been added to ERDAS IMAGINE: 

• OSTN15(NTv2) OSGB to ETRS: This datum transformation is to be used to do transformation from 

OSGB36 (EPSG:27700) to ETRS89 (EPSG:4258) 

 

• OSTN15(NTv2) ETRS to OSGB: This datum transformation is to be used to transform GNSS 

measurements in ETRS89 (EPSG:4258) to OSGB36 National Grid coordinate system (EPSG:27700) 

ORDNANCE SURVEY GEOID MODEL (OSGM15) 

OSGM15 has replaced OSGM02 as the official Geoid Model and definition of the relationship between GNSS 
ellipsoid heights and orthometric height in Great Britain 

The geoid and transformation models enable heights and positions collected using satellite positioning (e.g. 
GPS) to be transformed from the ETRS89 system to the national height datum used across mainland Great 
Britain (ODN) and the additional vertical datums that are used on the surrounding islands. 

SAVING MEASUREMENTS TO VECTOR/FEATURE ATTRIBUTES 

If you make a Measurement using the Measurement tool (e.g. Height from Layover) you have control over 
what units are used to display that measurements in the CellArray and in the Annotation that might be 
created. For example, you might be displaying a RPC NITF and measure the height of a building, but you 
want to see that height in Feet. That conversion works fine. 

There is also the ability to Measure to Attribute, which adds the measured value into an attribute field for the 
selected vector feature. 
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Previously this attribution worked, but always in the native units determined by the image’s geometry model. 
So, in the instance of a RPC NITF, where heights values are usually modelled in Meters, the measurement 
might be displayed in Feet, but would be added to the attribute field in Meters. 

With Update 2 the Measure to Attribute option respect the selected units settings (in the Setup group) and 
sends the converted values into the attribute field (e.g. record the feet equivalent value for the height 
measurement). 

SENSOR AND FORMATS 

FORMOSAT-5 SENSOR SUPPORT 

Support for FORMOSAT-5 Rigorous Orbital sensor model is added. 
 
FORMOSAT-5 is an Earth observation satellite operated by the National Space Organization (NSPO) of 
Taiwan.  

FORMOSAT RPC SENSOR SUPPORT 

Support for FORMOSAT RPC model is added. This adds support to FORMOSAT imagery delivered with 
RPC metadata. 

TRIPLESAT RPC SENSOR SUPPORT 

Support for TripleSat RPC model is added.  
 
The TripleSat satellite constellation is made of three identical optical earth observation satellites, with daily 
coverage of the earth and delivers 0.8m Panchromatic and 3.2m, 4-band Multispectral (Blue, Green, Red, 
NIR) imagery products.  

ENVI HEADER VARIANT 

Some hardware vendors were creating hyperspectral image product in the ENVI/AISA binary image format 
with a slight variation in the way the. hdr header was formatted. The specification requires the wavelength 
information to be a continuous string, but this variant placed each band’s wavelength on a separate line in the 
.hdr. The raster format handler has been enhanced to cater for this variant. 

SICD V1.2 SUPPORT 

SICD NITF files in the v1.2 profile are now supported.  
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SYSTEM REQUIREMENTS 

ERDAS IMAGINE  

Computer/ Processor 
64-bit: Intel 64 (EM64T), AMD 64, or equivalent  

(Multi-core processors are strongly recommended) 

Memory (RAM) 16 GB or more strongly recommended 

Disk Space 

⚫ 6 GB for software 

⚫ 7 GB for example data 

Data storage requirements vary by mapping project1  

Operating Systems 2, 3 

⚫ Windows® 7 SP1 or higher, Professional and Ultimate (64-bit) 

⚫ Windows® 8 (Standard), Professional and Enterprise (64-bit) 4 

⚫ Windows® 8.1 (Standard), Professional and Enterprise (64-bit) 4 

⚫ Windows 10 Pro and Enterprise (64-bit) 

⚫ Windows Server 2012 R2 (64-bit)  

⚫ Windows Server 2016 (64-bit) 

Software 

⚫ OpenGL 2.1 or higher (this typically comes with supported graphics cards5) 

⚫ Adobe® Reader® 7 or higher 

⚫ Internet Explorer® 9 or higher with JavaScript enabled, or Firefox® 32 or higher 

with JavaScript enabled 

⚫ Java Runtime 1.7.0.80 or higher - IMAGINE Objective requires JRE and can 
utilize any installed and configured JRE of version 1.7.0.80 or higher. 

⚫ Python 3.4.x (Python is optionally usable with Spatial Modeler. In most cases 64-
bit Python is required; however, if you run 32-bit ERDAS IMAGINE / Spatial 
Model Editor, or configure smprocess to not run 64-bit, 32-bit Python is also 

required) 

⚫ Microsoft DirectX® 9c or higher 

⚫ .NET Framework 4.0 

⚫ MSXML 6.0 

⚫ OpenCL 1.2 with a device which supports double precision (cl_khr_fp64) if 
wishing to GPU accelerate NNDiffuse and other OpenCL accelerated Operators 

Recommended 
Graphics Cards 

⚫ NVIDIA® Quadro® P6000, P5000, P4000, P2000 6 
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⚫ NVIDIA® Quadro® M6000, M5000, M4000, M2000 6  

⚫ NVIDIA® Quadro® K5200, K5000, K4200, K4000, K2200 6 

Recommended Stereo 
Display Monitors 

⚫ 120 Hz (or above) LCD Monitors with NVIDIA 3D Vision™ Kit 

Peripherals 

All software installations require: 

⚫ One Windows-compatible mouse with scroll wheel or equivalent input device  

⚫ Printing requires Windows-supported hardcopy devices 7 

Software security (Hexagon Geospatial Licensing 2018) requires one of the following: 

⚫ Ethernet card, or  

⚫ One USB port for hardware key 

Advanced 3D data collection in IMAGINE Photogrammetry (Including ORIMA & PRO600) 
requires one of the following hand controllers: 8 

⚫ TopoMouse™ or TopoMouse USB™ 

⚫ SoftMouse 3D 

⚫ Z/I Mouse  

⚫ Stealth Z, S3-Z model, USB version 

⚫ Stealth V, S3-V type (add as a serial device) 

⚫ Stealth 3D (Immersion), S3D-E type, Serial Port 

⚫ 3Dconnexion SpaceExplorer  

⚫ MOUSE-TRAK  

⚫ Immersion 3D Mouse 

⚫ EK2000 Hand Wheels 

⚫ EMSEN Hand Wheels 

ArcGIS and GeoMedia 
Interoperability 

⚫ ERDAS IMAGINE can be safely installed on a computer that has GeoMedia 
2014, GeoMedia 2015, GeoMedia 2016 or GeoMedia 2018 installed. However 
for greatest compatibility, it is highly recommended to install matching versions 

(including Updates). 

⚫ ERDAS IMAGINE 2018 requires GeoMedia 2018 for live linking. Order of 
installation does not matter. 

⚫ ERDAS IMAGINE (32-bit) can interact with both types of Personal 
Geodatabases (*.mdb and *.gdb). 

⚫ ERDAS IMAGINE can be safely installed on a computer that has ArcGIS® 
versions 10.1 through 10.6.1 
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⚫ ERDAS IMAGINE and IMAGINE Photogrammetry (32-bit) can interact with 
ArcGIS Server 10 Geodatabase servers (ArcSDE). To read or interact with an 
Enterprise Geodatabase, you must either:  

⚫ Install and license the appropriate version of ArcGIS for Desktop versions 10.1 

through 10.6.1, or  

⚫ Install the IMAGINE Geodatabase Support (based on ArcEngine 10.5), which 

requires no license 

Database Engines 

⚫ PostGIS 2.2: PostGIS can be used to store Features (.pfp) 

⚫ Oracle Server 12c 12.1.0.2.4 64-bit: Oracle Server 12c can be used to store 
Oracle GeoRaster (.ogr) (requires Oracle Spatial), SDE Raster (.sdi) (requires 
ArcGIS for Server) and Oracle Spatial Features (.ogv) (requires Oracle Spatial), 
as well as Features (.ofp). 

⚫ Microsoft SQL Server 2014: Microsoft SQL Server 2014 can be used to store 
Features (.sfp) 

ERDAS IMAGINE SYSTEM REQUIREMENTS NOTES 
1 Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity. 
Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk improves 
performance. Disk arrays improve productivity, but some RAID options slow performance. Network disk 
drives are subject to network limitations.  

2 Server Operating Systems are not supported for IMAGINE Photogrammetry, ORIMA or ERDAS ER Mapper. 

3 The 3D stereo viewing and peripheral requirements of IMAGINE Photogrammetry limit its operating system 
options.  

4 ERDAS ER Mapper is not supported on Windows 8. It is considered Viable on Windows 8.1. 

5 Windows provides a generic OpenGL driver for all supported graphics cards. However, an OpenGL-
optimized graphics card and driver are recommended for these applications.  

6 Grahics Card Certification is done using Nvidia Driver version 411.63. 

6 Some cards require DP to DVI-D dual-link adaptor. Be sure to use dual-link adaptors that are USB powered 
such as BizLink XT625 and Accell B087B-002B or B087B-007B models.  

6 All monitor cables must be dual-link DVI to support stereo display. 

6 Some cards require 8-pin PCIe power cables. Make sure your computer's power supply provides this type of 
power cable, or use a 6-pin to 8-pin PCIe power adaptor cable. 

7 HP-RTL drivers are recommended. Windows 64-bit print servers require 64-bit print drivers.  

8 Stealth S-Mouse (S2-S model) and MOUSE-TRAK are the only supported hand controllers in Stereo 
Analyst® for ERDAS IMAGINE.  
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ISSUES RESOLVED 

IMAGINE ESSENTIALS 

Issue ID 
Summary – 
IMAGINE 
Essentials 

Description / How to Reproduce 

IM-45503 File > Open > 
Multi Layer 
Arrangement does 
not work as 
expected when 
opening a virtual 
stack of images 

When opening a virtual stack of multiple raster images with either the Multi Layer 
Arrangement or Three Layer Arrangement options, it does not work correctly if you 
use the <Ctrl> key to select the individual images in the File Chooser. The number 
of layers will not increase past two when you have more than two files selected. 
This stops the user from using their desired band order as they can only choose 
band 1 or 2 for each color channel. This problem does not occur using ERDAS 
IMAGINE 2016 v16.1.  

The workaround solution is to select the Multiple tab and click on “Multiple Images 
in Virtual Stack” even though this option is already highlighted by default.  

Another workaround is to select the files in a block using the <Shift> key, but this 
only works if all of the images to be used are organized in sequential alphabetical 
order.  

Steps to reproduce:  

1. File tab > Open > Three Layer Arrangement or Multi Layer Arrangement  

2. In Open Three Layer file chooser, navigate to the location of the four 
individual Landsat-8 files.  

3. Press <Ctrl> key to select three of the files individually.  

4. Notice that the number of bands does not increase past two. 

 

IM-44405 Changing the 
Break Points and 
applying to that 
image, then 
Clearing the View, 
crashes ERDAS 
IMAGINE 

Steps to reproduce: 

1. Launch ERDAS IMAGINE and load example data: *XS_Truecolor_sub.img* 

2. Click Multispectral tab, select *Adjust Radiometry* menu, select 
*Breakpoints*. 

3. Change the breakpoints, set Apply To *Image File*, then click *Apply All*. 

4. Select *Yes* and *OK* in the messages 

5. Clear the 2D view and click *Yes* on Verify on save message. 

Observe that ERDAS IMAGINE crashes when trying to save the changes done to 
the image. 

IM-44548 ERDAS IMAGINE 
crashes in some 
cases when using 
MSP with Image 
Chain 

There are certain "operations" that will reliably crash ERDAS IMAGINE when an 
image is loaded as Image Chain and you try to use MSP.  

We have discovered 2 of them so far. One is when you zoom very far in (so you can 
see individual pixels) to do a very precise pixel measurement. The other is when 
you rotate the image (e.g. up is up) before trying to make a measurement.  
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IM-45113 Cannot move or 
delete files on 
system after 
image has been 
cleared from 
Viewer 

When a raster image is displayed in a 2D View, and then you clear it from the View, 
it does not get released. You cannot move or delete the file using Windows Explorer 
until ERDAS IMAGINE has been closed. The same thing does not occur with vector 
Shapefiles. This also does not happen in the previous version of ERDAS IMAGINE 
(v16.1, build 650).  

Steps to reproduce:  

1. Save the example file “germtm.img” to the desktop.  

2. Start ERDAS IMAGINE 2018 v16.5.1 (build 1058).  

3. Display the raster image “germtm.img” in a 2D View.  

4. Clear the image from the 2D View.  

5. Attempt to delete the file from the desktop.  

6. A message opens “The action can’t be completed because the file is open 
in ERDAS IMAGINE”.  

7. Close ERDAS IMAGINE and now the file can be deleted or moved. 

IM-43511 Start Processing 
Later Batch 
functionality does 
not work 

A simple batch process "Submit | Start Processing Later At… " does not start in 
Windows 10 machine. The "Submit | Start Processing Now" does work. 

IM-45379 Point Cloud 3D 
View drops tiles 
entirely from view 

Steps to reproduce:  

1. Open .las data in a 2D View. 

2. Click Show 3D.  

In the 3D point cloud viewer, entire tiles of data that are displayed initially gets 
dropped from the view as you zoom in, tilt the display and rotate the display. 

This does not happen with ERDAS IMAGINE 2016 Update 1.  

Note also that it's possible to zoom in to a point where all tiles cease rendering and 
you have a blank screen. Do not zoom in so far that you are seeing between the 
points. Instead, note that at one moment you have a screen filled with points, then 
rotate the mouse scroll wheel a single notch and everything goes blank. Back out a 
notch and it comes back. This makes the tool extremely difficult to use with certain 
data.  

IM-43789 4x4 pyramid layer 
generation 
produces 
“algorithm wrong” 
message 

Steps to reproduce:  

1. Open an image in ImageInfo or Image Command tool.  

2. Make sure the Session Log is visible.  

3. Select to calculate external 4x4 pyramid layers. Do not bother calculating 
stats.   

Thousands of messages like this appear in the Session Log:  

14/03/18 14:01:46 SessionMgr(7608): 4x4 resample not provided enough input 
data...something is wrong with the algorithm  

Eventually - no pyramids are generated.  

IM-45189 Sub-Images tab 
sometimes not 
being shown 
properly when 
selecting image 
from recent list 

Steps to reproduce:  

1. Using the File Chooser, open a multi-segment NITF image in a 
2DView. Notice that you get a Sub-Images tab.  

2. Open the File Chooser again and select air-photo-1.img and air-photo-
2.img. Do NOT click OK. Notice that you now have a Multiple tab.  

3. Click Recent button, select  7seg_igeolo.ntf and click OK. Notice that the 
Multiple tab is still shown instead of the Sub-Images tab.  

This worked in ERDAS IMAGINE 2016.   
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IM-45230 LAS as Raster 
fails to get file 
metadata for large 
LAS files 

Open a LAS file that has a million or more points as Raster (using LAS file as 
Raster data type). Then open ImageInfo and look at the File metadata. 

  

Observe that the CellArray is populated with unreadable characters 

IM-45089 Palestine 1923 / 
Palestine Grid 
modified (EPSG 
7142) is incorrectly 
defined 

Palestine 1923 / Palestine Grid modified (EPSG 7142) is incorrectly defined 

IM-45207 Coordinate 
reprojection from 
NZTM (EPSG 
2193) to-from 
NZMG (EPSG 
27200) is shifted 
approximately 5 
meters 

A discrepancy of around 5 meters is observed when comparing results of 
reprojection from NZTM to / from NZMG and comparing with values provided by 
LINZ, the customer observed a discrepancy of around 5m.  

While looking at the EPSG Registry for EPSG: 27200, it is found that ERDAS 
IMAGINE is using the “Geodetic Datum 1949” (instead of New Zealand Geodetic 
Datum 1949 as per EPSG Registry).  

IM-45382 Resample Pixel 
Size tool is not 
working with 
WGS84 / 
Geographic CRS 
data 

Resampling to a new cell size using the Resample Pixel Size dialog fails when the 
image to be resampled is in WGS84 / Geographic CRS (EPSG 4236). This does 
not happen for other CRSs.  

 

 

IM-45801 Interferometric 
SICD not opening 

Parsing the metadata from certain NITF SICD data (intended for interferometric 
SAR processing) could either hang or crash ERDAS IMAGINE. 

 

IMAGINE ADVANTAGE 

Issue ID 
Summary – 
IMAGINE 
Advantage 

Description / How to Reproduce 

IM-45054 Resampling of 
calibrated image 
failing 

Steps to reproduce:  

1. Launch ERDAS IMAGINE 2018 Update 1 (v16.5.0.1058).  

2. Select Resample Pixel Size from Raster > Resolution > Spatial.  

3. Provide the input file that was calibrated.  

4. Provide the output image name, cell size as 10, 10 and click OK.  

5. Observe that process failing - which was not the case in ERDAS IMAGINE 
2018 (without Update 1 installed). 
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IM-45041 MosaicPro 
crashes while 
creating output for 
this workflow 

ERDAS IMAGINE 2016 Update 1  

1) Open the Raster layers into a 2D View.  

2) Go to Toolbox Tab > Mosaic > MosaicPro from 2D View (or launch MosaicPro 
first and load the images). 

3) In the table below, tick all images under *Vis.* column and click Display raster 
images button.  

4) Under Edit menu select *Individual* *Image Radiometry* option.  

5) Select one of the images in the MosaicPro viewer and change the Brightness 
and Contrast.  

6) Under Edit menu select *Color Corrections* option.  

7) Check both *Use Illumination Equalizing* and *Use Image Dodging*.  

8) Now click *Set* button for *Use Illumination Equalizing* and check both *Perform 
Equalization* and *Apply to all images* check boxes and click *OK*.  

9) Click *Yes* in *Attention* dialog and click *OK* in *Color correction* dialog.  

10) Now click on the lightning bolt button to *Run* the process.  

11) Click *Yes* on the Attention dialog for calculating the Image dodging statistics. 

Observe that the MosaicPro tool crashes without producing the output. 

IM-43940 Problem with 
Subset tool and 
MosaicPro in 
subsetting JP2 file 
by shapefile / AOI 

Customer is subsetting JP2 file by using shapefile / AOI in the Subset tool as well 
as in MosaicPro. ERDAS IMAGINE is able to subset the output into another JP2 
file.  

But in the output JP2 file you will not see any georeferencing information. If the 
customer clips the image in ER Mapper, the Georeferencing information is 
transferred to the output JP2 file. 

IM-38284 Attention dialog 
opens to save 
Zonal Change 
project, though 
Save button is 
selected before 
closing 

Steps to Reproduce: 

 

1. Create a Zonal Change project.  

2. Do some edits and then click Save button. 

3. Close the project using the Close button (in Process tab).  

 

Observe that Attention dialog appears asking to save the Zonal Change project 
even though no changes have been made since the last save. 

IM-46573 MosaicPro 
crashes when  
panning  /  use 
panning tool,  after 
creating seamline 

MosaicPro crashes or hangs indefinitely when panning images after creating 
seamline. 

The CRS of the images in the mosaic project is Double Stereographic/ Bessel 
Spheroid (EPSG 28992) 

 

 

IM-45062 Image Equalizer 
doesn’t generate 
output  in TIFF 
format 

Image Equalizer (2018) does not generate output files in TIFF format. This used to 
work in the ERDAS IMAGINE 2013 version. 

If you choose to output Tiled TIFF, you may specify the width and height of the tiles.  
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IMAGINE PHOTOGRAMMETRY 

Issue ID 
Summary – 
IMAGINE 
Photogrammetry 

Description / How to Reproduce 

IM-44626 RMSE results 
changes slightly 
when triangulation 
is rerun 

In IMAGINE Photogrammetry 2018, Slightly different RMSE results are obtained 
when triangulation is re-run repeatedly (with same parameters) for a orbital push 
broom model (which is similar to Pleiades Model).  

IM-45714 Point Cloud 
Volumetric 
Analysis is 
creating partial 
output. 

When running Point Cloud Volumetric Analysis using an AOI as a boundary data, 
only a portion of the area delineated by the AOI is processed. 

 

IM-45060 Converting DTMs 
in XYZ to IMG 
format creates 
gaps at the edges 

Gaps are created at the edge of tiles being converted, or IMG tiles being merged 
when converting DTMs in XYZ to IMG format, as well as merging DTMs in IMG 
format. 

 

 

 

IMAGINE SAR INTERFEROMETRY 

Issue ID 
Summary – 
IMAGINE SAR 
Interferometry 

Description / How to Reproduce 

IM-44850 Coregister Radar 
Images Help page 
should be updated 

Steps to Reproduce: 

1. Launch ERDAS IMAGINE 2018 

2. Launch Coregister Image Pair from Raster > Radar Toolbox > Geometric 
Tools.  

3. Click Help button. 

Help topic should be updated with *UpSampling* parameter, introduced in ERDAS 
IMAGINE 2018.  

IM-45223 PAZ SAR support 
in ERDAS 
IMAGINE 

Hisdesat is the owner and operator of the PAZ satellite, which offers precise 
information for multiple applications from its polar orbit around the Earth. 

They are using ERDAS IMAGINE 2018 and they would like ERDAS IMAGINE 2018 
be modified to be able to read PAZ products directly. 

Currently PAZ format is available on the Files of Type menu, but it is not working. 
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SPATIAL MODELER 

Issue ID 
Summary – 
Spatial Modeler 

Description / How to Reproduce 

IM-45065 Model containing 
Raster Statistics 
per Feature is 
throwing error 

ERDAS IMAGINE 2018 Update 1  

Steps to reproduce: 

1. Click Toolbox tab > Spatial Model Editor.  

2. Open the model. 

3. First *Run* the model and then *Preview*.  

Observe that *Preview 3* is not loaded in the 2D Viewer and it throws an error  
 

IM-44911 Create Centerline 
and related 
operators need to 
call new API to 
appropriately set 
primary geometry 
of features 

Create centerline and other Geometry creating operators need to call 
SetPrimaryGeometryFieldname (a new API that was put in place for ERDAS 
IMAGINE 2018) for appropriately setting primary geometry field. 

IM-45679 Get AWS 
Landsat8 Scenes 
operator does not 
download the most 
recently acquired 
scenes 

The Get AWS Landsat8 Scenes operator does not download the "Most recently 
acquired" scenes.  

Customer is using “Get AWS Landsat8 Scenes” operator, and set the options “Most 
recently acquired” and the NewScenesDirectories. They are using a shapefile from 
which they set the inquire box to be the boundary region. When the customer ran 
the model, they only get an old scene from 2017, instead of a scene from 2018 that 
they expected. When they changed parameters, they received an even older scene.  

 

IM-45938 Set Primary 
Geometry 
Operator fails on 
null geometry 

Set Primary Geometry Operator fails when attempting to set primary geometry on 
features containing null geometry.  

error message: Spatial Model failed in Set Primary Geometry. Error was Specified 
method is not supported.  

IM-45188 Point Cloud 
Measure Volume 
operator is not 
working with 
customer’s las file 
and polygon 
shapefile 

The Point Cloud Measure Volume operator is not working with customer’s las file 
and the polygon shapefile. 

Customer reported that they can not run volumetric analysis using a Spatial Model 
using the Point Cloud Measure Volume operator with their las file and shapefile. It 
gives the following error message, which seems to be related to Coordinate 
Reference System mismatch, although they have the same CRS: 

“Failed to recognize Authority Code with Authority "GeoKey Moniker" and Authority 
Code 
"1,1,0,13/1024,1/2048,7084/3072,32767/3074,32767/3075,8/3076,9001/3078,44.00
0000000000007/3079,49.000000000000014/3084,3.0000000000000004/3085,46.5
00000000000007/3086,70 )À±Eìø ” 

The same las file and the shapefile does work in the Volumetric Analysis dialog. 
Also, if an aoi is created from the shapefile, then the customer’s Spatial Model does 
generate an output. 

IM-44979 Get Related 
Filenames model 
has the input data 
references in it 

GetRelatedFilenames.gmdx delivered with SMSDK, when opened in Spatial Model 
Editor, the input port is already filled in with some information. This should be 
removed.  



 

Issues Resolved 

October 30, 2018 35 

IM-45316 Point Cloud 
Volume gives 
wrong results for 
2D boundary 
shapefile or AOI 
file 

Run the model for IM-45188 and observe the output shapefile attributes. Note that 
the values are different compared to those when running point cloud volume with 
the point cloud tools. This is because the Z values are all zero. 

IM-45043 Loading output 
from Subset SAR 
Image Pair 
operator throwing 
series of errors 

Steps to reproduce: 

1. Launch ERDAS IMAGINE 2018, open Spatial Model Editor. 

2. Drag Subset SAR Image Pair operator to the Editor  

3. Provide the Reference File and Match file from respectively:  
dims_op_oc_dfd2_204280199_1    dims_op_oc_dfd2_204280215_1  

4. Provide the output file names as subsetreference.img and subset 
match.img and run the model with all other ports as default.  

5. After completion of process load the subsetmatch.img in the 2D viewer 
and observe series of errors saying that units are not of same type with a 
warning message -Current Map is unusable. 

NOTE  

Even after providing bounding box, error is also reproduced. 

IM-44892 NNDiffuse not 
clipping output to 
intersection 

Steps to reproduce: 

1. Add a Raster Output to the NNDiffuse model and run it.  

2. Open the output image in a 2DView.  

3. Move your cursor horizontally across the image, noticing that the image 
name in the TOC is red (indicating that the cursor is over the image).  

4. Continue moving your cursor into the "background" on the right edge of the 
image, noticing that the image name remains red until you get significantly 
to the right. This is because all the "background" is actually part of the 
image.  

5. If you Stack Layers the pan and MS and output the results of that, the 
output image is only the overlap (intersection) area. 

For geometrically calibrated (referenceable) input images the extent of the Pan 
should be processed. For orthorectifed (geoereferenced) input images the 
intersection of the Pan and MS should be processed. 

IM-44890 Half pixel offset 
when outputting to 
NITF format 

Steps to reproduce: 

1. Display chart1-geo.img in a 2D View  

2. Start the Subset tool and specify chart1-geo.img as input (if it does not 
default to that).  

3. Specify an output filename but make sure to select NITF as the output 
format.  

4. Run.  

5. Overlay the output NITF on the original image (you may want to do so 
using Image Chain).  

6. Swipe to note a half pixel offset.  

This appears to be a general issue outputting to NITF from Spatial Modeler, not just 
Subset.  

IM-45436 SMSDK 2018 
Welcome page 
says 2016 

HTML Welcome page for the 2018 SMSDK documentation says "2016". 
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IM-44050 Progress of 
operators in sub-
model not showing 
up on sub-model 

Steps to reproduce: 

1. Create a Spatial Model with a Raster Input connected to Statistics.  

2. Turn on Force Recompute. 

3. Set the input raster to a large enough raster that you can see the progress 
of stats.  

4. Run the model.  

5. You should see the progress bar at the bottom right of the window 
reporting the progress of the Statistics operator AND the progress of the 
Statistics operator showing up on the operator itself.  

6. When it finishes, select the Statistics operator and click Create Submodel. 

7. Now rerun the model.  

8. Progress bar at the bottom of the window will update, but the progress will 
not show up on the Submodel operator until you refresh the screen. 

Seems to be working in ERDAS IMAGINE 2016 Update 1, but is broken in ERDAS 
IMAGINE 2018. 

IM-45505 Point Cloud 
Classify does not 
RGB encode all 
points 

Basically the model just takes points.las and runs it through Point Cloud Classify 
with default parameters to produce points_classified.las.  

If you display the two side-by-side, you see that there is a pattern (looks like tile 
edges?) of missing points from the output. 

But they are not missing. They simply have not been assigned the correct RGB 
values, so they are black. If you change to display by Elevation you see them again. 

IM-45506 Point cloud 
classification 
increases the 
number of points 
in the output file 

Original point cloud data (points.las) – 15,354,198 points  

Classified point cloud data (points_classified.las) – 15,391,313 points  

The output point cloud data has 30K+ additional points.  

IM-43610 Focal Standard 
Deviation operator 
is creating File 
pixel value of 
#.##### in raster 
output 

When using Focal Standard Deviation function, customer gets pixel values of "-
#.############", hence an undefined value. These pixel values occur at places 
where the mathematical standard deviation should be 0 (flat terrain).  

Problem is, that these values neither can be removed with “ReplaceNoData” nor by 
replacing all negative values with "0". This causes problems in the subsequent 
workflow, such as these 'data holes' are enlarged by the matrix of the Focal 
Function operator.  

Steps to reproduce:  

1. Run the customer’s model containing Focal Standard Deviation operator 
with customer data.  

2. Use the Inquire Cursor to look at the following coordinate (45.89782745, 
6.13665914). In the original data, the value at the same coordinate was 
444. 

3. File Pixel Value will show only as #.####### 
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IM-45042 Set Terrain Height 
operator failing 
when shapefile is 
in EPSG:2154 

Steps to reproduce: 

1. Run set_z_high.gmdx model with 8 mai dem1mm.tif image and 
emprise_globale.shp. 

2. Model will fail with an error: "Failed to recognize Authority Code with 
Authority "GeoKey Moniker" and Authority Code 
"1,1,0,13/1024,1/2048,7084/3072,32767/3074,32767/3075,8/3076,9001/3
078,44.000000000000007/3079,49.000000000000014/3084,3.000000000
0000004/3085,46.500 
000000000007/3086,700000.0/3087,6600000.0/4096,5773" 

3. When using emprise_globale_utm.shp (UTM WGS84) or 
emprise_globale_wgs.shp (Geographic Lat/Long) result are as expected. 

IM-44552 Per Feature 
operators creating 
mostly 0's in 
output 

Computing Variance Texture per Feature results in all 0s in the output attribute 
except for the features that touch the top of the image footprint.  

The same behaviour is observed with Statistics Per Feature operator.  

IM-44916 FeatureSubset::G
etFeatureInfo 
loses primary 
geometry field 
name 

The implementation FeatureSubsetData::GetFeatureInfo is not maintaining all of the 
information managed by FeatureInfo because it is creating a new Fields collection 
and populating the fields and CRS definitions. It also needs to copy the number of 
points and primary geometry field definition. 

IM-45281 Extent of 
interpolated 
surface not large 
enough 

With a LAS file (with basic ground classification), take just the ground class points, 
interpolate a ground surface and use that surface to Normalise the point heights.  

But the process leaves a periphery of points that have not been normalized (and 
are therefore higher than the majority of the points) all around the edge. This is 
most obvious if you display the result in 3D.  

Assumption is that this is caused by the extent of the interpolated surface not 
extending all the way to the edges. But this should not be allowed to happen. If the 
DEM does not cover the extent of the point cloud being processed by Normalize 
Heights, the non-intersecting points should be excluded from the results or 
otherwise marked as "not processed".  

In this instance, you would also expect the interpolated surface to have the extents 
of the input point cloud. Of course the non-ground points are deleted in the model, 
so the extent will be affected, but there are definitely ground points being missed by 
the Normalize process. 

 

IMAGINE EXPANSION PACK - NITF 

Issue ID 
Summary – NITF Description / How to Reproduce 

IM-45077 Positional shift 
exporting Pleiades 
DIMAP to NITF 

DIMAP .xml image IMG_PHR1A_MS_002 has been pre-processed using Raster 
tab > Geometry group > Geometric Calibration > Calibrate with Sensor Model and 
Terrain. Model selected is PLEIADES RPC and Elevation Source is changed to be 
Constant (60m).  

1. Started the "NITF 2.1 from Imagery" exporter, fed in the calibrated .xml 
and specified an output name (exported_nitf.ntf). 
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2. In the Export NITF tertiary dialog, specified JPEG2000 compression, 
Numerically lossless, EPJE. Kept all the other defaults and clicked OK to 
run the export.  

3. Result is exported_nitf.ntf. 

Checked to made sure exported_nitf.ntf was still calibrated with RPCs and using 
average terrain height of 60m still.   

 

However, when comparing the original .xml and the .ntf in ImageInfo, note that the 
ULX, Y is different between the two images.  

Overlay the two and perform a swipe to see the offset. 

The shift is on the order of 4m (in the multispectral data, which is ~2m pixels)  

IM-45765 SNIP NITF 
opening Quick 
Look by default 

Open a SNIP NITF file (without descending into the Sub-images tab) into a 2D View 
and note that the Quick Look is opening rather than the main image. The Quick 
Look should generally be ignored. 

IM-44351 Big multi-segment 
NITF (mosaic) as 
Image Chain is too 
slow 

Classified multi-segment (mosaic) NITFs are opening extremely slowly in ERDAS 
IMAGINE 2018 as Image Chain (or anything else).  

 

 

ERDAS IMAGINE INSTALLATION 

Issue ID 
Summary – 
Installation 

Description / How to Reproduce 

IM-45066 Borrowing is not 
working correctly 
in the latest 
version of 
licensing 

With the names within the current IMAGINE2018.xml delivered with ERDAS 
IMAGINE installer, borrowing has the following issues:  

* Cannot borrow IMAGINE Professional  

* Cannot borrow IMAGINE Photogrammetry  

There needs some change of names within the IMAGINE2018.xml in order for the 
borrowing to work.  
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ABOUT US 
Hexagon Geospatial helps you make sense of the dynamically changing world. We enable you to envision, 
experience and communicate location intelligence. Our technology provides you the form to design, develop 
and deliver solutions that solve complex, real-world challenges. Ultimately, this is realized through our 
creative software products and platforms. 

CUSTOMERS. Globally, a wide variety of organizations rely on our products daily including local, state and 
national mapping agencies, transportation departments, defense organizations, engineering and utility 
companies, and businesses serving agriculture and natural resource needs. Our portfolio enables these 
organizations to holistically understand change and make clear, reliable decisions. 

TECHNOLOGY. Our priority is to deliver products, platforms and solutions that make our customers 
successful. Hexagon Geospatial is focused on developing technology that displays and interprets information 
in a personalized, meaningful way. We enable you to transform location-based content into dynamic and 
useable business information that creatively conveys the answers you need.  

PARTNERS. As an organization, we are partner-focused, working alongside our channel to ensure we 
succeed together. We provide the right platforms, products, and support to our business partners so that they 
may successfully deliver sophisticated solutions for their customers. We recognize that we greatly extend our 
reach and influence by cultivating channel partner relationships both inside and outside of Hexagon.  

TEAM. As an employer, we recognize that the success of our business is the result of our highly motivated 
and collaborative staff. At Hexagon Geospatial, we celebrate a diverse set of people and talents, and we 
respect people for who they are and the wealth of knowledge they bring to the table. We retain talent by 
fostering individual development and ensuring frequent opportunities to learn and grow. 

HEXAGON. Hexagon Geospatial is part of Hexagon, a leading global provider of information technology 
solutions that drive productivity and quality across geospatial and industrial landscapes. Hexagon’s solutions 
integrate sensors, software, domain knowledge and customer workflows into intelligent information 
ecosystems that deliver actionable information. They are used in a broad range of vital industries.  

Hexagon (Nasdaq Stockholm: HEXA B) has more than 18,000 employees in 50 countries and net sales of 
approximately 4.2 bn USD. Learn more at hexagon.com and follow us @HexagonAB. 
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COPYRIGHT  

© 2018 Hexagon AB and/or its subsidiaries and affiliates. All Rights Reserved. Hexagon has registered trademarks in many countries 
throughout the world. Visit the Trademarks Page for information about the countries in which the trademarks are registered. See 
Product Page and Acknowledgements for more information. 

Product Documentation Terms of Use 

PLEASE READ THESE TERMS CAREFULLY BEFORE USING HEXAGON GEOSPATIAL’S DOCUMENTATION ("DOCUMENT"). USE 
OF THIS DOCUMENT INDICATES ACCEPTANCE OF THIS AGREEMENT WITHOUT MODIFICATION. IF YOU DO NOT AGREE TO 
THE TERMS HEREOF ("TERMS"), DO NOT USE THIS DOCUMENT. 

Use Of This Document 

All materials in this Document are copyrighted and any unauthorized use may violate worldwide copyright, trademark, and other laws. 
Subject to the terms of this Agreement, Hexagon Geospatial (a Division of Intergraph Corporation) and Intergraph’s subsidiaries 
("Intergraph") hereby authorize you to reproduce this Document solely for your personal, non-commercial use. In consideration of this 
authorization, you agree to retain all copyright and other proprietary notices contained therein. You may not modify the Materials in any 
way or reproduce or publicly display, perform, or distribute or otherwise use them for any public or commercial purpose, except as 
specifically authorized in a separate agreement with Hexagon Geospatial.  

The foregoing authorization specifically excludes content or material bearing a copyright notice or attribution of rights of a third party. 
Except as expressly provided above, nothing contained herein shall be construed as conferring by implication, estoppel or otherwise any 
license or right under any copyright, patent or trademark of Hexagon Geospatial or Intergraph or any third party. 

If you breach any of these Terms, your authorization to use this Document automatically terminates. Upon termination, you will 
immediately destroy any downloaded or printed Materials in your possession or control. 

Disclaimers 

ALL MATERIALS SUPPLIED HEREUNDER ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, OR NON-INFRINGEMENT. Hexagon Geospatial does not warrant that the content of this Document will be 
error-free, that defects will be corrected, or that any Hexagon Geospatial Website or the services that make Materials available are free 
of viruses or other harmful components. 

Hexagon Geospatial does not warrant the accuracy and completeness of this Document. Hexagon Geospatial may make changes to this 
Document at any time without notice. 

Limitation Of Liability 

IN NO EVENT SHALL HEXAGON GEOSPATIAL BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR 
CONSEQUENTIAL DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA OR USE, INCURRED BY YOU OR ANY 
THIRD PARTY, WHETHER IN AN ACTION IN CONTRACT OR TORT, ARISING FROM YOUR ACCESS TO, OR USE OF, THIS 
DOCUMENT. 

Indemnification 

You agree to defend, indemnify, and hold harmless Hexagon Geospatial, its officers, directors, employees, and agents from and against 
any and all claims, liabilities, damages, losses or expense, including reasonable attorneys’ fees and costs, arising out of or in any way 
connected with your access to or use of this Document. 

Use Of Software 

Use of software described in this Document is subject to the terms of the end user license agreement that accompanies the software, if 
any. You may not download or install any software that is accompanied by or includes an end user license agreement unless you have 
read and accepted the terms of such license agreement. Any such software is the copyrighted work of Hexagon Geospatial, Intergraph 
or its licensors. Portions of the user interface copyright 2012-2018 Telerik AD. 

Links To Third Party Websites 

This Document may provide links to third party websites for your convenience and information. Third party websites will be governed by 
their own terms and conditions. Hexagon Geospatial does not endorse companies or products to which it links. 

https://www.hexagongeospatial.com/legal/trademarks
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Third party websites are owned and operated by independent parties over which Hexagon Geospatial has no control. Hexagon 
Geospatial shall not have any liability resulting from your use of the third party website. Any link you make to or from the third party 
website will be at your own risk and any information you share with the third party website will be subject to the terms of the third party 
website, including those relating to confidentiality, data privacy, and security. 

Trademarks 

The trademarks, logos and service marks ("Marks") displayed in this Document are the property of Hexagon Geospatial, Intergraph or 
other third parties. Users are not permitted to use Marks without the prior written consent of Hexagon Geospatial, Intergraph or the third 
party that owns the Mark. "Intergraph" is a registered trademark of Intergraph Corporation in the United States and in other countries. 
Other brands and product names are trademarks of their respective owners. 

Find additional trademark information. 

Procedure For Making Claims Of Copyright Infringement 

Notifications of claimed copyright infringement should be sent to Hexagon Geospatial by mail at the following address: Intergraph 
Corporation, Attn: Intergraph Legal Department, P.O. Box 240000, Huntsville, Alabama 35824. 

US Government Restricted Right 

Materials are provided with "RESTRICTED RIGHTS." Use, duplication, or disclosure of Materials by the U.S. Government is subject to 
restrictions as set forth in FAR 52.227-14 and DFARS 252.227-7013 et seq. or successor provisions thereto. Use of Materials by the 
Government constitutes acknowledgement of Hexagon Geospatial or Intergraph’s proprietary rights therein. 

International Use 

You may not use or export Materials in violation of U.S. export laws and regulations. Hexagon Geospatial makes no representation that 
Materials are appropriate or available for use in every country, and access to them from territories where their content is illegal is 
prohibited. 

Hexagon Geospatial provides access to Hexagon Geospatial international data and, therefore, may contain references or cross 
references to Hexagon Geospatial products, programs and services that are not announced in your country. These references do not 
imply that Hexagon Geospatial intends to announce such products, programs or services in your country. 

The Materials are subject to U.S. export control and economic sanctions laws and regulations and you agree to comply strictly with all 
such laws and regulations. In addition, you represent and warrant that you are not a national of, or otherwise located within, a country 
subject to U.S. economic sanctions (including without limitation Iran, Syria, Sudan, Cuba, and North Korea) and that you are not 
otherwise prohibited from receiving or accessing the Materials under U.S. export control and economic sanctions laws and regulations. 
Hexagon Geospatial makes no representation that the Materials are appropriate or available for use in every country, and access to 
them from territories where their content is illegal is prohibited. All rights to use the Materials are granted on condition that such rights are 
forfeited if you fail to comply with the terms of this agreement. 

Revisions 

Hexagon Geospatial reserves the right to revise these Terms at any time. You are responsible for regularly reviewing these Terms. Your 
continued use of this Document after the effective date of such changes constitutes your acceptance of and agreement to such changes. 

Applicable Law 

This Document is created and controlled by Hexagon Geospatial in the State of Alabama. As such, the laws of the State of Alabama will 
govern these Terms, without giving effect to any principles of conflicts of law. You hereby irrevocably and unconditionally consent to 
submit to the exclusive jurisdiction of the United States District Court for the Northern District of Alabama, Northeastern Division, or the 
Circuit Court for Madison County, Alabama for any litigation arising out of or relating to use of this Document (and agree not to 
commence any litigation relating thereto except in such courts), waive any objection to the laying of venue of any such litigation in such 
Courts and agree not to plead or claim in any such Courts that such litigation brought therein has been brought in an inconvenient forum. 
Some jurisdictions do not allow the exclusions or limitations set forth in these Terms. Such exclusions or limitations shall apply in all 
jurisdictions to the maximum extent allowed by applicable law. 

Questions 

Contact us with any questions regarding these Terms. 

https://www.hexagongeospatial.com/about-us/our-company/contact-us
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